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Introduction 

HBV hydraulic model was designed by Sten Bergström in 1972.  It was improved by SMHI 
(Swedish Meteorology and Hydrology Institute) in order to be used inside Sweden in 1976. 
Therefore, HBV and its different versions were used in approximately 30 countries up until today.   
 
This is a conceptual model, which is easy to understand, learn and apply. It has proved good 
results in several basins that it was applied. It has been used as a standard model for the flow 
estimation lessons especially in northern countries.  
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BHM (Beray Hydrology Model) Software 

BHM software is HBV based flow estimation software developed by Beray Engineering, 

Construction and Information Technologies.  

System requirements 

Windows XP, Windows Vista, Windows 7, Windows 8 operating systems. 

Microsoft .Net 4.0 or upper versions. 

Installation 

Installation file is “setup.exe” file. In order to install the software, this file is clicked and 

installation is completed by following the instructions in the installation window.  
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Software 

BHM software calculates flow, using meteorological estimation, precipitation and temperature 

data in a certain basin by means of the parameters that were applied by algorithm processing 

monitored rain, temperature and flow values.  

In “C:\” disc, “BHM” file is generated, when the program is started to run. While the new 

generated project is saved, it is saved under this directory unless a different file is not selected 

by the user. 

 

Sbapshot1.1 – BHM Main Screen 

Generating a new project 

New project generation screen is opened by “New” menu entry under “File” menu or by the “New 

project” icon inside the toolbar. 

 

Snapshot 2.1 – BHM New Project Generation Menu Entry 

 

Snapshot 2.2 – BHM New Project Generation Toolbar Icon 

Project parameters are opened with initial values in “Generate New Project” screen. This screen 
consists of four tabs.  

“Basin Parameters”  
“Elevation – Vegetation regions”  
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“Average Monthly Evaporation and Temperature Values” 
“Monitored Rain, Temperature and Flow Values” 

 

Snapshot 2.3 – BHM New Project Generation Screen Basin Parameters Tab 

The name of the project is entered into “Project Name” field. 

“Basin Parameters” group; 
“Area” value is the total area of the basin [km²] 
“Pcalt” value is the precipitation change in the basin in every 1000 meters [mm] 
“Tcalt” value is the temperature change in the basin in every 100 meters  
“Cet” value is the characteristic parameter of the basin 
“PERC” value is the characteristic parameter of the basin 
“UZL” value is the characteristic parameter of the basin 
“Maxbas” value is the characteristic parameter of the basin  
“K0” value is the characteristic parameter of the basin 
“K1” value is the characteristic parameter of the basin 
“K2” value is the characteristic parameter of the basin 
  

If no other values except “Area” value in this group are known, the initial values of the program 
must remain. A new project cannot be generated unless an “Area” value higher than zero is 
entered. 
 
“Basin Initial Values” group shows initial values; 

“SnowPack” value is the initial snow amount value of the basin [mm] 
“SUZ” value is the water amount in the initial upper groundwater zone of the basin [mm] 
“SLZ” value is the water amount in the initial lower groundwater zone of the basin [mm] 
“SoilMoisture” value is the initial soil moisture amount of the basin [mm] 

 
If the values in this group are unknown, they must remain “0”. Initial values are automatically 
calculated while the program makes the calculation. 
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The “Forward” button at right bottom part of the screen leads to the next step in generating a 
new project.  
 
 

 

Snapshot 2.4 – BHM New Project Generation Screen Elevation – Vegetation Regions Tab 

Different elevation regions and vegetation regions of the basin are described in “Elevation – 
Vegetation Regions” tab. Elevation regions or vegetation regions might be added or deleted with 
the use of “+” and “-” buttons. Basin must contain at least 1 elevation region or 1 vegetation 
region. The amount of “Elevation – Vegetation Regions Intersection Areas” is same with the 
multiplication of elevation regions and vegetation regions.   There are 3 areas in this group. The 
value sum of these 3 areas has to be 1. The value must be given with the assumption that total 
area of the basin is 1. If more than 1 region exists, not only one intersection point, but the sum 
of all intersection point areas must be 1. If there is a lake in the basin, lake and total area of its 
intersection points have to be 1. 

 
“Elevation Region Parameters” group; 

“Elevation” area is the altitude of the region [m] 
“Vegetation Region Parameters” group; 

“TT” value is the freezing temperature of the vegetation region [C °] 
“BETA” value is the characteristic parameter of the basin 
“FC” value is the characteristic parameter of the basin  
“LP” value is the characteristic parameter of the basin  
“SFCF” value is the characteristic parameter of the basin 
“CFMAX” value is the characteristic parameter of the basin 
“CFR” value is the characteristic parameter of the basin 
“CFSlope” value is the characteristic parameter of the basin 
“CWH” value is the characteristic parameter of the basin 

If the values in this group are unknown, initial values of the program must remain. 
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“Elevation – Vegetation Region Intersection Areas” group;  

“No” value represents the intersection area belongs to elevation region and vegetation 
region number, respectively.   
“East - West Area” value is the area that is apect to east and west directions of the 
intersection area. Must have a value between 0 and 1.  
“South Area” value is the area that is aspect to south direction of the intersection area. 
Must have a value between 0 and 1. 
“North Area” value is the area that is aspect to north direction of the intersection area. 
Must have a value between 0 and 1.  

“Lake Parameters” group; 
“Area” is the value of the lake area inside the region. The value must be entered 
assuming total basin value is 1.  
“Elevation” value is the altitude of the lake. If the lake is at the flow accumulation center 
of the basin, altitude is presumed as 0. Altitude must be given by assuming the bottom 
point of the basin is 0.  

“TT” value is the freezing temperature of the lake water [C°]. 
“SFCF” is the characteristic value of the lake. 

 
 “Undo” button at the left bottom of the screen leads to the previous stage for generating a new 
project. 
 “Forward” button at the right bottom of the screen leads to the next stage for generating a new 
project. 
 
 

 
 

 
 

Snapshot 2.5 – BHM New Project Generation Screen Monthly Average Evaporation and Temperature Values Tab 
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“Average Evaporation“ values [mm]  and “Average Temperature” values [C°] must be entered in 
“Monthly Average Evaporation and Temperature Values” tab. “Month” values represents the 
month numbers in a year (1=January, 2=February, 3=March, 4=April, 5=May, 6=June, 7=July, 
8=August, 9=September, 10=October, 11=November, 12=December). Monthly values entered, 
represent all the days in that month. 
 
“Load from the file” button is used to load the values from “.txt” file. First line of the text files 
must be the definition line and program does not take them into account. 12 values are read one 
under the other, starting from the second line.  
 
Accurate calculation and load of these parameters significantly affects the success of the flow 
estimation.  
 
 “Undo” button at the left bottom of the screen leads to the previous stage for generating a new 
project. 
 “Forward” button at the right bottom of the screen leads to the next stage for generating a new 
project. 

 
Snapshot 2.6 – BHM New Project Generation Screen Monitored Precipitation Temperature Flow Values Tab 

BHM Test Basin Monthly Evaporation Data 
0.05 
0.14 
0.46 
1.5 
3.01 
4.15 
3.66 
2.72 
1.42 
0.43 
0.03 
0  
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Monitored precipitation, temperature and flow values of the basin are read from “.txt” formatted 

file in “Monitored Precipitation Flow Temperature Values” tab via “Load Precipitation Temperature 

Flow Values” button. First line of the text file must be the definition line and program does not 

take them into account. Program respectively reads “day”, “precipitation”, “temperature” and 

“flow” values. There must be only one day’s information in every line. Otherwise, program will 

give reading error. 
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Sample file must be as below: 

Day     Precipitation  Temp. Flow 
19810101 0 -1 0.002 
19810102 0 -3.6 0.005 
19810103 0.2 -8 0.005 
19810104 0.1 -10.3 0.005 
19810105 0 -15 0.005 
19810106 0 -17.6 0.004 
19810107 0 -12.8 0.004 
19810108 1.2 -4.7 0.004 
19810109 1.7 3 0.018 
19810110 0 -3.4 0.04 

 

Day format must be as “yyyyMMdd” (19810101), “dd.MM.yyyy” (01.01.01981) or “d.M.yyyy” 
(1.1.1981). All the days in the file must be written in the same format. ‘y’ letter represent year 
information, ‘M’ letter represents month information and ‘d’ letter represents day information. 
 
“Undo” button at the left bottom of the screen leads to the previous new project generation step.  
“Save“ button at the right bottom of the screen generates a new project. This button brings the 
project selection screen for the user in order to save the project, if clicked. Described project is 
saved to the designated directory after the selection of the folder. Project file has a “.bhm” 
extension. A file named “Project Files” is generated at the same directory with this file. ‘sqlite’ 
database file is present in this file. Changes to these files must not be made in order to ensure a 
proper functioning of the project.  
 
After the successful save of the project, it can be opened automatically with the BHM program. 
This process might vary couple of minutes according to the observed data mass and computer 
processing speed. 
 

Opening a project 

Requested project load file carrying a “.bhm” extension is selected via “Open” sub-menu item of 
“File” menu or project selection screen that is opened by “Open Project” icon and project is 
loaded to the program. This process might vary couple of minutes or more according to the 
observed data mass and computer processing speed. 
 
 

 

Snapshot 3.1 – BHM Open Project menu item 
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Screenshot 3.2 – BHM “Open Project” toolbar icon 

Saving a project 

Changes made to the project are saved via “Save” sub-menu item of “File” menu or “Save 

Project” icon in the toolbar. Save operation is irreversible. The changes to the project cannot be 

saved to project file if the program is shut down without saving the project.  Save process might 

take a couple of minutes or more if there are several changes to the observed data. 

 

 

Snapshot 4.1 – BHM Project save menu item 

 

 

Snapshot 4.2 – BHM Project save toolbar icon 

Closing the project 

“Close the Project” sub-menu item in “File” menu is used to shut down the loaded project in  

BHM program. 
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Screenshot 5.1 – BHM Project shut down menu item 

Updating basin attributes 

“Basin Data” sub-menu item and “Basin Menu” screen is opened from “Project” menu. 

 

Snapshot 6.1 – BHM Basin data menu item 

 

 

Snapshot 6.2 – BHM Basin data update screen 

Intended data changes are made in the screen and screen is closed.  
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The changes here are kept in the memory after the screen is closed. Updated data are used if a 

calculation is intended.  Project must be saved in order to save the changed data  

Please see “Generate a New Project” section for detailed information on parameters. 

Adding-removing an elevation zone / Updating lake parameters 

“Elevation –Vegetation – Lake Region Parameters” screen is opened via “Elevation –Vegetation – 

Lake Region Parameters” sub menu item in project menu. 

 

Snapshot 7.1 – BHM Elevation –Vegetation – Lake Region Parameters menu item 

 

 

Snapshot 7.2 – BHM Elevation –Vegetation – Lake Region Parameters Update Screen 

Intended data changes are made in the screen and screen is closed. Elevation regions or 
vegetation regions might be added or deleted with the use of “+” and “-” buttons. Basin must 
contain at least 1 elevation region or 1 vegetation region. The amount of “Elevation – Vegetation 
Regions Intersection Areas” is same with the multiplication of elevation regions and vegetation 
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regions.   There are 3 areas in this group. The value sum of these 3 areas has to be 1. The value 
must be given with the assumption that total area of the basin is 1. If more than 1 region exists, 
not only one intersection point, but the sum of all intersection point areas must be 1. If there is a 
lake in the basin, lake and total area of its intersection points have to be 1. 
 
The changes here are kept in the memory after the screen is closed. Updated data are used if a 

calculation is intended.  Project must be saved in order to save the changed data  

Please see “Generate a New Project” section for detailed information on parameters. 

 

Updating Monitored Rain Temperature Flow Data 

 “Monitored Rain Temperature Flow Data” screen is opened via ‘Monitored Rain Temperature 

Flow Data’ sub-menu item in the “Project” menu. 

 

 

Snapshot 8.1 – BHM Monitored Rain Temperature Flow Data Update menu item 

  

Snapshot 8.2 – BHM Monitored Rain Temperature Flow Data Update screen 
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Intended data changes are made in the screen and screen is closed. The changes here are kept 

in the memory after the screen is closed. Updated data are used if a calculation is intended.  

Project must be saved in order to save the changed data  

Please see “Generate a New Project” section for detailed information on parameters. 

Updating Average Monthly Evaporation and Temperature Values 

“Average Monthly Evaporation and Temperature Values” screen is opened via ‘Average Monthly 

Evaporation and Temperature Values’ sub-menu item in the “Project” menu. 

 

 

Snapshot 9.1 – BHM Average Monthly Evaporation and Temperature Values Update menu item 

 

  

Snapshot 9.2 – BHM Average Monthly Evaporation and Temperature Values Update screen 

Intended data changes are made in the screen and screen is closed. The changes here are kept 

in the memory after the screen is closed. Updated data are used if a calculation is intended.  

Project must be saved in order to save the changed data  
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Please see “Generate a New Project” section for detailed information on parameters. 

Calculation of flow estimation 

“Calculate flow value” screen is opened via ‘Start’ sub-menu item in the “Calculate” menu item or 
“Start (Calculate flow)” icon in the toolbar. 
 

 
Snapshot 10.1 – BHM Flow Calculation Menu item 

 

 

Snapshot 10.2 – BHM Flow Calculation Toolbar icon 

 

 

Snapshot 10.3 – BHM “Calculate flow values” screen 

 

Estimated flow of the basin is calculated with clicking “Calculate” button after selecting beginning 
and ending dates.  
 
 “Table”, “Graphic” and “Error Rates” buttons appears in the screen after the flow is calculated. 
“Table” button is the display of the results on the table. This screen consists of two tabs; 
 “Flow Results” 
 “Detailed Results” 
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 ‘Date’, ‘Observed Flow’ and ‘Simulated Flow’ values are displayed in table format in the “Flow 
Results” tab. Other calculated parameters calculated in “Detailed Results” tab are added to the 
screen in table format. Table in the screen is saved to the described directory by the user in “.xls” 
(excel) format with “save” button. 
 

 
 
Snapshot 10.4 – BHM Flow Results Table Screen  

 
“Graphic” button displays the results in graphics. This screen consists of two tabs; 
 “Monitored – Simulated Flow” 
 “Snow Cover” 
“Save” button in this screen saves the graphic in the screen to the described directory by the 
user in “.jpg” format. 
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Snapshot 10.5 – BHM Flow Results Graphic Screen 

 
“Error Rates” button calculates and displays Error rates between the observed flow and the 
simulated flow in the screen. Please see “Error Rates” section for detailed information on Error 
rates. 
 

 
 
Snapshot 10.6– BHM Flow Results Error Rates Screen  
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Calibration of basin parameters 

 
Basin calibration screen is opened via ‘Calibrate – Monte Carlo Simulation’ sub-menu item in 
“Calculate” menu or  ‘Monte Carlo Simulation’ icon in toolbar.  
 

 

Snapshot 11.1 – BHM Basin Calibration Menu Item 

 

Snapshot 11.2 – BHM Basin Calibration Toolbar Icon 

 

 

Snapshot 11.3 – BHM Monte Carlo Simulation Screen 
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Lower or upper limits in “Vegetation Region Parameters” and “Basin Parameters” groups are 
described. The program automatically prints the optimal values of these limits on the screen. 
Value ranges might be decreased if necessary. It is not suggested to increase the value range. 
Intended beginning and ending dates of calibration is selected in “Calibration Alternatives” group.  
“Simulation Number” value is the number that defines how many times the basin will be 
calibrated. 
Calibration is started with “Start” button after defining Error parameters in “Error Filters” group. 
Please see “Error Parameters” section for more information on Error parameters. 
 
Calibration results are in “Results” group. Calibrations that pass through error filters are displayed 
in “Results” section.  
 

 

Snapshot 11.4 – BHM Calibration Results 

Error values of the results are displayed at the left section. Parameter values generated by the 
result of calibration are displayed at the right side of the clicked result. “Save” button saves the 
values in “.xls” format to the user described directory.  
“Load project” button changes the parameter values of the selected result with loaded project 
parameter values. This operation is irreversible. Data are saved to ‘.bhm’ project file. 
 

Closing the project 

“Exit” sub-menu item in “File” menu or “x” program item at right top of the program is used to 

close the program. 

 

Snapshot1 2.1 – BHM Program Closing Sub-menu item 
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HBV Hydrology Model   

 

 

It is basically formed of 4 modules: 

 

     Input    Output 

Snow Module  precipitation 

 temperature 

 snow cover 

 snow melt 

Soil Module  potential evaporation 

 precipitation 

 snow melt 

 act. evaporation 

 soil moisture 

 groundwater recharge 

Response function  groundwater recharge  runoff 

 groundwater level 

Routing routine  runoff to creek  calculated runoff 

 

Snow Module 

It is the module that snow covers and snow melts are calculated and processed after deciding 

whether the precipitation will fall to the basin surface as rain or snow.  The form of the 

precipitation is decided according to freezing point threshold value of water (TT) that 

differentiates due to the elevation and pressure of the basin. If the temperature is lower than this 

value precipitation will be estimated as snow and if temperature is over this value precipitation 

will be estimated as rain, and it is processed. 

 

 T : Temperature [Cº] 

Precipitation 

     Rain      Snow 

Liquid water 

Snow melt 

Soil moisture 

Evapotranspiration 

Surface flow 

Interflow 

Baseflow 

Runoff 
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 TT : Water freeze temperature [Cº] 

 

 If, T > TT → rain  

  

  T < TT → snow 

 

If the precipitation is in snow form, the amount is multiplied by SFCF parameter and added to the 

snow cover on the surface.  

 

 P : Amount of precipitation 

 SP : Snow cover 

 SFCF : Snow Fall Correction Factor 

 

 SP=SP+(P∗SFCF )  
 

In the situation that air temperature is over the threshold value, day temperature equation is used to 

calculate snow melt of the snow cover. Generally having values between 1.5 and 1.4; CFMAX is 

the determining factor in calculating snow melt (Lower values in vegetation areas) 

 
 CFMAX : Day factor coefficient [mm d·¹ Cº·¹] 

 

 melt = CFMAX (T – TT) 

 

Water content consists of melting snow and rain. There is certain water holding capacity of the 

snow at the surface. This capacity is calculated with the help of CWH parameter. This amount is 

subtracted from total water ingredient and liquid water is calculated. 

  

 WC : Water content 

 Insoil : Liquid water ( Water that reaches to the soil) 

 CWH : Water holding parameter of the snow 

   

            WC = melt + rain 

 

 Insoil=WC−(CWH∗SP )  
 

In situations that air temperature is lower than the threshold level and liquid water is formed, a 

certain amount of liquid water transforms into ice. CFR parameter is used for this calculation. 

Degrease amount of liquid water is calculated with this parameter according to another region’s air 

temperature threshold level while water passes through this region.  

 

 CFR : Freezing parameter of liquid water 

 

 SP=SP+CFR∗CFMAX∗(TT−T)  
 

 WC=WC−CFR∗CFMAX∗(TT−T )  
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Soil Module 

An amount of the water that reaches to soil surface evaporates to the atmosphere. Evaporation 

occurs from soil surface, accumulated water surface and via plants. Plants deliver water from the 

earth in order to use it for photosynthesis. Majority of photosynthesis water is released back to the 

atmosphere as a result of transpiration of the leaves in photosynthesis process. Contextualizing of 

evaporation in earth and water accumulation and transpiration of plants is called as 

evapotranspiration. Calculation of evapotranspiration is one of the major components of the 

model. Therefore, the impact of the temperature on the flow is substantial while it is high in 

summer months. 

 

A certain amount of water reaches to the earth surface evaporates, a certain amount of it generates 

the soil moisture and remaining amount feeds the underground water. 

 

 DQ : Groundwater  

 SM : Soil moisture  

 FC : Maximum capacity of the soil 

 β : Figure parameter 

 

 DQ= Insoil( t)[
(SM (t−1))

FC
]

β

 

  

 

Every region has a different humidity capture capacity due to the earth structure and depth. 

Evaporation must be calculated beforehand to be able to calculate the humidity of the earth. 

 

 Tavg : Average temperature 

 Epm : Average evaporation 

 Ep : Potential evaporation 

 Cet : Model parameter  

  

 Ep(t )=Epm(1+Cet [T (t)−Tavg(t )])  
 

When soil moisture is over FC*LP, real evaporation occurs at the same speed with potential 

evaporation. When soil moisture is lower than FC*LP, real evaporation is lower than potential 

evaporation. 
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Ea : Real evaporation 

LP : soil permanent wilting point coefficient 

 

If ; 

 

SM<FC∗LP→Ea( t)=Ep( t)[
(SM (t−1))

(FC∗LP)
]  

 
SM≥FC∗LP→Ea(t)=Ep(t)  

 

 

Soil moisture is acquired by subtracting surface flow and real evaporation from the sum of initial 

humidity and liquid water. 

 

 

 
SM (t)=SM (t−1)+P−DQ−Ea  

 

 

Response Function 

This module estimates the flow at the exit of the basin relying on layer concept. The system 

consists of two conceptual layers that are over each other. First layer is used for the modeling of 

surface water and flows reaching lower layer and second layer is used for simulating base flow. 

These two layers are directly connected to each other by the usage of a constant drainage ratio 

(Qperc). 

 

 

Surface flow forms the flows on the earth surface. Interflow represents the bottom side of the 

upper zone flows. Finally baseflow represents the flows at the lower zone. The bottom surface of 

the lower zone is an impermeable layer, which its top surface border is the water surface border of 

the lake inside the basin.  

Surface flow 

Interflow 

Bottom flow 

Runoff 

Liquid Water 
Actual evapoartion 

SM Soil 

Moisture 

Baseflow 
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Q0 : Near surface flow 

Q1 : Inter flow 

Q2 : Base flow 

Qperc : Percolotion 

 

SUZ : Storage in upper zone 

SLZ : Storage in lower zone 

 

UZL : Treshold parameter 

Kperc : Descriptive parameter 

 
SUZ>UZL→Q0=(SUZ−UZL)K0  

 
SUZ≤UZL→Q0=0  

 
Q1=SUZ K1  
 
Qperc=SUZ Kperc  

 
Q2=SLZ K2  

 

 
SUZ (t)=SUZ (t−1)+DQ(t)−Q1−Q2−Qperc  

 
SLZ (t )=SLZ (t−1)+Qperc−Q2  

 

Routing Routine 

Time delays of subsurface flow in joining the flow is calculated with this module. Simulation flow 

is acquired by a triangular weight function, which its parameter is defined as MAXBAS, via 

summing up flow amounts. 

 

Qsim= ∑
(i )

MAXBAS

c (i)Qtotal( t−i+1)  

 

c (i)= ∫
(i−1 )

(i)

(
2

MAXBAS
)−

MAXBAS

2

4

MAXBAS
2
du  

 

 

Flow 

Days 

Days 
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Error calculation 

RMSE 

Average square root Error (RMSE) is a simple and effective formula used in calibration process. It 

is acquired by taking the square root of; square sum of the difference between daily observed 

and simulated amount, divided to total day numbers.  

 

 

 

 Qs : Simulated flow 

 Qo : Observed flow 

  

 
RMSE=√

∑
i=1

n

(Q s(t )−Qo( t))
2

n

  

 

 Ideal RMSE = 0  

Pearson product-moment correlation coefficient 

Pearson product-moment correlation coefficient (Rp) is the coefficient that describes the direction 

and magnitude of relation between independent variables.  This coefficient takes a value 

between (-1) and (+1). While positive values describe direct linear relationship, negative values 

describe opposite direction linear relationship. There is no linear relationship between the 

variables if the correlation coefficient is zero.  

  

 Qo : Average observed flow 

 

 Q s : Simulated average observed flow 

 

March May April July June 

http://tureng.com/search/pearson%20product-moment%20correlation%20coefficient
http://tureng.com/search/pearson%20product-moment%20correlation%20coefficient


28 

 

 R p=

∑
i=1

n

(Qo−Qo)(Q s−Qs)

√∑
i=1

n

(Qo−Qo)
2

√∑
i=1

n

(Q s−Q s)
2

 

 

 R p=−1→Ters yönlü doğrusal ilişki  

 

 R p=0→Doğrusal ilişki yok  

 

 R p=1→Direk yönlüdoğrusal ilişki  

 

Nash-Sutcliffe model yield coefficient 

Nash-Sutcliffe model yield coefficient (RNS) (Yield coefficient) is an effective formula for 

evaluation of estimation strength of the simulation. 

 

 RNS=1−

∑
t=1

n

(Q s(t)−Qo(t))
2

∑
t=1

n

(Qo(t )−Qo)
2

 

 

If : 

 RNS=1→Mükemmel uyum ,Qs=Qo   

 

 RNS=0→Gözlenenortalama yağış doğruluğukadar iyi ya da kötüuyum  

 

 RNS<0→Çok kötüuyum  

 

Perfect coherency 

Very bad coherency 

Good or bad  coherency according to  the monitored  precipitation amount 

Opposite direction linear relationship 

There is no  linear relationship 

Direct  linear relationship 
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